Aerial_Master_2012_2014_v0_28 Version History
Edited by AAB
19 February 2020

Mike Hay updated the Block field to “1a” for the following events:
YEAR Flt_No Event
2012 21 459
2012 42 355
2012 45 382
2013 7 377
2013 14 385
2013 14 391
2013 29 17
2013 32 620
2013 32 800
2014 2 511
2014 6 175
2014 17 279
2014 17 624
2014 17 946
2014 17 954
2014 17 956
2014 21 502
2014 21 504
2014 24 939
2014 24 1273
2014 27 359
2014 27 402
2014 27 410
2014 27 414
2014 28 977
2014 243 564

AAB mapped all Block 1 events and found more sightings along the Block 1 shoreline that were not
included in the Block 1 to Block 1a update because the Block 1a shapefile did not extend all the way to
overlap the shoreline. AAB updated these events to Block 1a:

ID Event Flight Date

165991 979 28 9/26/2014 16:53

Updated new baitball sighting to Block 15 (was updated in vO_27 from a note on a non-sighting entry to
a sighting, but the Block field was not updated):

ID Event Flt_No GMT_Minus8_DateTime Block

22375 452 228 18-Aug-12 15
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Carcass updates:

2012:

E396, F213, 7/21/2012 — added to notes: frames 1-6. Killer whale predation.

E38, F223, 8/12/2012 — added to notes: frames 1-4. Killer whale predation.

E344, F226, 8/16/2012 — added to notes: frames 37-60. Killer whale predation.

E590, F230, 8/20/2012 — added to notes: frames 112-127; Killer whale predation.

E134, F231, 8/21/2012 — added to notes: frames 18-39. Killer whale predation.

E559, F232, 8/23/2012 — Species = gray whale, notes = “frames 60-74. Killer whale predation; sp
updated to gray whale from unid (knuckles visible)”

E214, F233, 8/25/2012 — added to notes: frames 15-26. Suspect killer whale predation.

E330, F233, 8/25/2012 — added to notes: frames 27-36. Killer whale predation.

E157, F236, 9/1/2012 — notes = “frames 8-12. Killer whale predation.”

E595, F240, 9/8/2012 — Species = gray whale, notes = “frames 4-13. sps updated to gray whale. Killer
whale predation.”

E17, F250, 9/24/2012 — added to notes: frames 1-17. Killer whale predation.

E544, F255, 9/30/2012 — Species = gray whale, notes = “frames 1-10. advanced decomposition. Sps
updated to gray whale. Killer whale predation.”

E551, F46, 10/6/2012 — notes = “frames 17-32. Killer whale predation.”

2013:

E725, F214, 8/1/2013 — notes = “frames 6-11. Killer whale predation.”

E747, F214, 8/1/2013 — notes = “frames 12-15"

E783, F214, 8/1/2013 — Species = unid marine mammal, notes = “frames 16-17. very decomposed;
species determination based on post-script photo analysis, updated Feb 2019; likely walrus.”

E328, F237,9/14/2013 — added to notes “Resighted 9/19/2013 F239, E210. Cause of death could not be
determined.”

E210, F239, 9/19/2013 — notes “repeat sighting of 9/14/13 F237, E328; cause of death could not be
determined via images of 1st sighting.”

2014:

E470, F215, 7/29/2014 — notes = “F10-23, clc. Postscript-carcass beached near Barrow on 8/2/14; NSB
documented, scars on belly matched to ASAMM photos. Resighted by ASAMM 8/27/14 F228 E356.”
E343, F228, 8/27/2014 — notes = “frames 1-7. Resighted 9/5/14 F233 E737. Suspect killer whale
predation.”

E356, F228, 8/27/2014 — notes = “repeat sighting of 7/29/2014 F215 E470 offshore of Wainwright that
later washed ashore near Barrow. NSB documented on 8/2/14 scars on belly matched to ASAMM
photos; killer whale predation based on images from 1st sighting.”

E305, F232, 9/4/2014 — added to notes: Cause of death could not be determined.

E523, F233,9/5/2014 — notes = “Resighted 9/23 F238 E1226. Cause of death could not be determined.”
E669, F233,9/5/2014 — notes = “Resighted 9/23/14 F238 E1411. Cause of death could not be
determined.”

E737, F233,9/5/2014 — notes = “Resight of 8/27/2014 F228 E343. Suspect killer whale predation (based
on images of original sighting)”

E1192, F238, 9/23/2014 — added to notes: Cause of death could not be determined.
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E1226, F238,9/23/2014 — Species = gray whale, notes = “advanced decom. Resight of 9/5/14 F233 E523.
Cause of death could not be determined.”

E1411, F238,9/23/2014 — Species = gray whale, notes = “F85-93, CA; Resight of 9/5/14 F233 E669. Cause
of death could not be determined. Post-script sps update based on images and resighting of whale
recorded as gray whale.”

Compacted & Repaired.
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Aerial_Master_2012_2014_v0_27 Version History
Edited by AAB
4 February 2020

ID 87934 F207 E502 (7/12/2013) — PhotoTaken 1

ID 192952-192980 F205 E270-298 (7/12/2014) (14 sightings) — notes “photos taken during circling E270-
298, J.Gatzke, frames 1-30”, PhotoTaken 1

ID 40210, E508, F256 (10/1/2012) — notes “J.Crance, frames 30-46; moderate decomp; large slick; lots of
birds. Species chgd based on post-script image review; possible resighting on 10/22/2012 F270 E171.
Injuries consistent with KW predation, R.Stimmelmayr (NSB DWM), 29Jan2018"

ID 104726, E234, F235 (9/11/2013) — Calfno 0, Calf_on_circle -1, notes “likely yearling; project camera
(B.Lynch) frames, 1-5; V.Beaver camera (S.Churches photographer) frames, 53-57. Injuries consistent
with KW predation, R.Stimmelmayr (NSB DWM), 21 Jan 2018”

ID 107746, E536, F239 (9/19/2013) — notes “frames 1-6 Stan Churches photographer. Moderate
decomp. Visual COD investigation: R.Stimmelmayr (NSB DWM) 31Mar2019 -killer whale predation, large
tissue defects on head, tongue missing”

ID 109497, E41, F242 (9/24/2013) — notes “frames 1-6 photographer J.Turner w/ birds. Moderate
decomp. Visual COD investigation: R.Stimmelmayr (NSB DWM) 31Mar2019 -suspect killer whale
predation, large tissue defect of head region”

ID 110466, E41, F244 (9/26/2013) — notes “frames 1-5. decomposed with birds. Moderate decomp.
Visual COD investigation: R.Stimmelmayr (NSB DWM) 31Mar2019 -no obvious injuries.”

ID 22375 E452 F228 (8/18/2012) — s on transect, Species baitball, Sightcue body, Habitat open water,
Final_group 1, sop |, Observer Karen Vale, PrimObs 1, Family 7, enttag 3

ID24321 F230 E879 (8/20/2012) — Entry s on transect, Species baitball, Sightcue body, Habitat open
water, Final_group 1, sop |, Observer Karen Vale, PrimObs 1, filled in environmentals from previous
entry, Block 12, notes “fish visible in area”, FltType 2, Transect_id 134, Family 7, enttag 3, filled in crew,
PhotoTaken 0, copied ArclLat/Long to Lat/LongTemp

ID 91590 F214 E726 — divert to circling, filled in environmentals from previous entry, FltType 6, enttag 1,
filled in crew, PhotoTaken O

ID 91594 F214 E730 - p on circling — search, FltType 6

ID91600 F214 E736 — resume, filled in environmentals from previous entry, FltType 4, enttag 1, filled in
crew, PhotoTaken 0
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Changed “baitball” to “bait ball”:

ID Event Flt_ No GMT_Minus8 DateTime
22375 452 228 8/18/2012 5:33:14 PM
24321 879 230 8/20/2012 5:26:31 PM

Compacted & Repaired.
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Aerial_Master 2012 2014 v0_26 Version History
Edited by AAB
21 December 2018

Some BWASP transects were found in the 2012 data that did not have transect ID assigned. Megan’s
code that assigned transect IDs retroactively to the BWASP study area included the following rule:

"If > max.buff.km of tx segment is outside of a longitudinal bin, no tx ID is assigned. If a segment crosses
into two bins and neither bin has > max.buff.km, the tx.id is assigned to the bin with the longest
segment. If a segment crosses multiple bins and only one bin has > max.buff.km, tx.id is assigned to the
bin with the longest segment.”

From Megan: | chose 5 km to be the threshold value, max.buff.km. I implemented this rule to avoid
assigning transect IDs to wacky transects that were created "on the fly" and don't match the standard
BWASP survey design. A problem occurs when > 5 km of transect effort for a given transect is located in
more than one longitudinal bin, but the transect still generally follows the standard BWASP survey
design. In those cases, the code left the transect ID blank. The three cases are shown in the attached
figures and listed below, along with my recommended solutions:

1. Flight 211, events 553-596: This transect is found in bins 33 and 34, but mostly in bin 34. | suggest
giving this a transect ID of 134.

2. Flight 221, events 207-343: This transect is found in bins 20 and 21, but mostly in bin 21. | suggest
giving this a transect ID of 121.

3. Flight 221, events 486-602: This transect is found right on the border of bins 23 and 24. | suggest
giving this a transect ID of 124.

Edits made to data:

7/19/2012 F211 E553-594 — Transect_id 134
8/5/2012 F221 E207-342 — Transect_id 121
8/5/2012 F221 E486-594 — Transect_id 124

Compacted & Repaired.
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Aerial_Master_ 2012 2014 v0_25 Version History
Edited by AAB
14 November 2018

Added fields:
Icepercent_|
Icepercent_r
assoc_event

In Design View of the Output table, copy/pasted the Description entries for those fields from the 2018
master database:

Added Icepercent_| Description: Estimate of the percent of ocean surface within the visual range of the
left observer (beginning in 2018)

Added Icepercent_r Description: Estimate of the percent of ocean surface within the visual range of the
right observer (beginning in 2018)

Added assoc_event Description: FltType 8, enttags 6 & 7 are populated with the Event number of the
FltType 8, enttag 3 they are associated with. FltType 8, enttag 3 are populated with the Event numbers
of the FltType 8, enttags 6 & 7 they are is associated with.

Changed the Block field from Number to ShortText in Design View:
(so that all Block fields are formatted the same throughout the master databases; in 2018, with the
inclusion of block 13N, the field had to be changed to ShortText.)

When trying to change the field to ShortText, Access gave me this error: Microsoft Access can't change
the data type. There isn't enough disk space or memory.

So | created a blank database/table with all the same table structure: copied the Design view of the
Output table and pasted it into a new table's Design view. That created a table with all the fields, but no
data yet. In this new table, changed Block to ShortText and saved it. Then ran an append query to
append the 2012-2014 master data into the new table. Copied the Flightinfo, Summaryinfo, and lut
tables into the new database.

Compacted & Repaired.
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Aerial_Master 2012 2014 v0_24 Version History
Edited by AAB
16 August 2018

Deleted lut_Observer and lut_Pilot tables.
Output table:

ID11210 E449 F209 — Calf_on_circle 4
ID179818 E315 F243 — Calf _on_circle 9
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Aerial_Master 2012 2014 v0_23 Version History
Edited by AAB
9 February 2018

ID 13605, E396, F213, 7/21/2012 — Species gray whale, add to notes: "species chgd based on post-script
image review; whale is too large for beluga, fluke not beluga shaped, sloughy dark pigmentation is
visible, paddle shaped pecs"

ID 22946, E348, F229, 8/19/2012 — Species walrus, notes: “sp. chgd based on post-script image review”

ID 37246, E643, F252,9/26/2012 — notes: “LVB, frames 41-68; species chgd based on post-script image
review. Injuries consistent with KW predation, R.Stimmelmayr (NSB DWM), 21Jan2018”

ID 40210, E508, F256, 10/1/2012 — notes: “J.Crance, frames 30-46; advanced decomp; large slick; lots of
birds. Species chgd based on post-script image review; possible resighting on 10/22/2012 F270 E171.
Injuries consistent with KW predation, R.Stimmelmayr (NSB DWM), 29Jan2018”

ID 104726, E234, F235,9/11/2013 — notes: “calf/yearling; project camera (B.Lynch) frames, 1-5;
V.Beaver camera (S.Churches photographer) frames, 53-57. Injuries consistent with KW predation,
R.Stimmelmayr (NSB DWM), 21 Jan 2018”

ID 114618, E1018, F247,9/30/2013 — notes: “black and white. For actual position, see repeat sighting
E1024; S.Churches frames 1-5. Injuries consistent with KW predation, R.Stimmelmayr (NSB DWM),
21Jan2018”

ID 114586, E1024, F247,9/30/2013 — notes: “Repeat of E1018, this is more accurate position;

S.Churches frames 1-5. Fresh dead with white scarring on flanks. Injuries consistent with KW predation,
R.Stimmelmayr (NSB DWM), 21Jan2018”
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Aerial_Master 2012 2014 v0_22 Version History
Edited by AAB
17 January 2018

ID 153254, E771, F13, Date 8/20/2014 — Behavior: removed trailing space from “spy hop “
ID 183378, E595, F247, Date 10/8/2014 — Behavior: removed trailing space from “spy hop “

ID 19477, E38, F223, Date 8/12/2012 - Species gray whale, notes “species determination based on post-
script photo analysis”

ID 37246, E643, F252, Date 9/26/2012 - Species bowhead whale, notes “species determination based on
post-script photo analysis”

ID 40210, E508, F256, Date 10/1/2012 - Species bowhead whale, notes “advanced decomposition; large
slick; lots of birds; species determination based on post-script photo analysis; possible resighting on
10/22/2012 F270 E171”

ID 114618, E1018, F247, Date 9/30/2013 - Species bowhead whale, Behavior dead, notes "black and
white. For actual position, see repeat sighting E1024"

ID 1146586, E1024, F247, Date 9/30/2013 - Repeat yes, notes "repeat of E1018, this is more accurate
position; frames 1-5; photographer Stan Churches; fresh dead with white scarring on flanks; possible

killer whale predation, based on post-script photo analysis"

ID 49298, E171, F270, Date 10/22/2012 — notes “images 4-8; likely the same whale as bowhead whale
sighted on 10/1/2012, F256, E508, based on post-script photo analysis”

ID 49298, E171, F270, Date 10/22/2012 — notes “images 4-8; likely the same whale as bowhead whale
sighted on 10/1/2012, F256, E508, based on post-script photo analysis”

ID 91647, E783, F214, Date 8/1/2013 - Species gray whale, notes “very decomposed; species
determination based on post-script photo analysis”
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Aerial_Master_ 2012 2014 vO 21 VH

Aerial_Master_2012_2014 v0_21 Version History
Edited by AAB
4 December 2017

Output table:

ID 105580 FLT236 E318 - Species unid shark
Summaryinfo table:

Deleted fields:

Bowhead_Calves
Bowhead_Calves_On_Transect

Renamed fields:

from Bowhead_Cow_calf_Pairs to Bowhead_Calves
from Bowhead_Cow_calf Pairs_on_transect to Bowhead_Calves_On_Transect
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Aerial_Master_ 2012 2014 vO 20 VH
Aerial_Master_2012_2014 vO_20 Version History
Edited by AAB
24 October 2017
Output table:

Family 6 (unid mar mam's and sm unid mar mam's):

ID Event FIt No GMT_Minus8 DateTime
3883 364 307 7/10/2012 1:36:44 PM
4896 406 309 7/12/2012 12:48:38 PM
13548 288 213 7/21/2012 11:39:31 AM
14300 93 214 7/22/2012 12:08:11 PM
53889 549 4 7/22/2012 2:05:58 PM
76303 579 37 9/23/2012 4:22:39 PM
37542 562 252 9/26/2012 1:30:28 PM
37591 568 252 9/26/2012 1:32:30 PM
44830 103 263 10/13/2012 12:21:48 PM
44839 112 263 10/13/2012 12:24:34 PM
87727 334 207 7/12/2013 12:09:58 PM
125676 319 9 8/4/2013 6:47:52 PM
94112 92 219 8/13/2013 2:30:53 PM
131467 342 17 8/23/2013 4:54:38 PM
131564 532 17 8/23/2013 5:55:18 PM
133047 141 20 8/26/2013 3:33:40 PM
103719 286 233 9/6/2013 11:42:34 AM
141618 206 33 9/25/2013 4:20:19 PM
195971 688 210 7/22/2014 1:56:14 PM
197063 408 212 7/25/2014 12:33:09 PM
198082 613 213 7/26/2014 3:17:38 PM
203436 638 219 8/6/2014 4:48:13 PM
177546 761 239 9/24/2014 6:19:55 PM
189706 689 256 10/29/2014 2:51:00 PM
Clino -1, X/YofWhale -1, chgd Lat/LongTemp to ArcLat/Long:
ID Event FIt No GMT_Minus8 DateTime
140855 261 32 9/23/2013 12:00:02 PM
142431 327 34 9/27/2013 1:10:47 PM
113238 909 246 9/29/2013 4:39:48 PM

Page 12



Aerial_Master_ 2012 2014 vO_19 VH
Aerial_Master_2012_2014 v0_19 Version History
Edited by AAB
12 April 2017
Output table:
-1D109497 F242 E41 (20130924) - removed from note: “gray whale?”

-Replaced all “Jess Taylor” to “Jessica Taylor”

-Removed trailing spaces from Behavior “run ”

ID Event FIt_No Date

186783 393 253 10/26/2014

189585 568 256 10/29/2014

201247 1022 217 7/31/2014

210687 274 231 9/1/2014

-Removed trailing space from Skycon "overcast "

ID Event FIt No Date

88760 86 209 7/15/2013

88768 94 209 7/15/2013

88772 98 209 7/15/2013

88774 100 209 7/15/2013

88845 103 209 7/15/2013

88855 113 209 7/15/2013

88858 116 209 7/15/2013

- Changed VislmpL and VisImpR from “n/a” to “none”
ID Event FIt No GMT_Minus8 DateTime

130010 380 15 8/20/2013 12:29:20 PM
129997 354 15 8/20/2013 12:17:57 PM
129983 331 15 8/20/2013 12:07:30 PM
129979 327 15 8/20/2013 12:05:57 PM
129825 369 15 8/20/2013 12:24:26 PM
129811 342 15 8/20/2013 12:12:06 PM
129810 341 15 8/20/2013 12:11:42 PM
129803 323 15 8/20/2013 12:04:39 PM
129796 316 15 8/20/2013 12:02:06 PM
129978 326 15 8/20/2013 12:05:47 PM
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Aerial_Master_ 2012 2014 vO_18 VH
Aerial_Master_2012_2014 v0_18 Version History
Edited by AAB
21 February 2017
Output table:
ID105337 F236 E146 - notes "PhotoTaken value of 1, but no photos found"

Swimdir entry changed to "."; Swimdir_True value changed to "-1":
ID Event FIt_No

1928 122 305
2377 553 305
10707 595 208
52504 384 2
52589 393 2
16691 468 217
59379 143 14
19858 512 223
23892 404 230
24156 747 230
29684 202 240
32129 454 243
47438 708 267
48107 361 268
99642 617 227
112813 436 246
117640 842 251
191434 260 203
191463 268 203
200720 730 217
153254 771 13
207770 357 226
167073 241 30
179704 261 243
180115 503 243
181480 323 245
Swimdir_True value changed to "-1":
ID Event FIt_ No
54663 369 5
21019 364 225
29504 22 240
44215 363 262
83784 74 202
144900 374 2
153187 704 13
181591 526 245
Calf_on_Circle value changed to "1":
ID Event FIt_No
4583 144 309
11194 424 209
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Aerial_Master_ 2012 2014 vO_18 VH

53772 501 4
16433 269 217
16532 295 217
45304 216 265
85083 545 203
85092 566 203
85178 575 203
120298 383 1
120382 410 1
120351 593 1
120638 746 1
121890 264 4
95829 808 222
95830 809 222
130499 900 15
131373 311 17
136182 191 24
136185 194 24
142813 149 35
143132 370 35
118239 205 252
194275 512 207
195204 443 209
195213 452 209
144208 506 1
203467 669 219
203483 685 219
203488 690 219
203492 694 219
203521 723 219
154707 132 15
158190 498 18
173484 798 236
182175 384 246
Calf_on_Circle value changed to "2":
ID Event FIt_No
2187 381 305
172142 1034 234
173518 813 236
Calf_on_Circle value changed to "3":
ID Event FIt_No
85881 111 204
Calf_on_Circle value changed to "4":
ID Event FIt_No
11210 449 209
Calf_on_Circle value changed to "9":
ID Event FIt_No
179818 315 243
153446 495 13
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Aerial_Master_ 2012 2014 vO_17 VH

Aerial_Master_2012_2014 v0O_17 Version History
Edited by AAB
11 January 2017

Output table:

Skycon "clear" (removed trailing space from "clear "):
ID202440 F218 E637
ID202444 F218 E641
1D202447 F218 E644
ID202461 F218 E647
ID202463 F218 E649
ID202472 F218 E658
ID202481 F218 E667
ID202483 F218 E669
ID202484 F218 E670
ID202486 F218 E672
ID202487 F218 E673
ID202500 F218 E675
ID202505 F218 E680
ID202509 F218 E684
ID202526 F218 E690
ID202529 F218 E693
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Aerial_Master_ 2012 2014 vO_16 VH

Edited by AAB
4 Nov 2016

Output table:

Changed 2013 and 2014 manual non-sighting entry Block nhumbers to "-1".
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Aerial_Master_ 2012 2014 vO_15 VH

Edited by AAB
11 Oct 2016

Output table:

Changed 2014 "deadhead" and "p on deadhead" event entries' Block numbers to "-1".
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Aerial_Master_ 2012 2014 vO_14 VH

Output table:

Updated Transect id field with Beaufort Sea transects (140W to 157W) using transect ID numbers
assigned by MCF, starting with 101 in the easternmost survey bin (140.0 to 140.5 W) and ending with

transect ID 134 near Barrow.
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Aerial_Master_2012 2014 vO_13 VH
Output table:

1D61364 FLT16 E460, 1D61280 FLT16 E469, 1D58841 FLT13 E633 (all 2012) - removed
trailing space in icepercent.

ID 6721 FLT203 E807 (2012) - Behavior "hauled out'™, notes "was sighted diving".

All combinations of Habitat = on ice, Behavoir = rest - Behavior changed to "hauled
out”™ (n=168).
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Aerial_Master_2012 2014 vO_12 VH
Output table:

In Design View, Descriptions to Field Names:

Icepercent - within description, changed (1979-1991, 2008-2013) to (1979-1991, and
starting again in 2008).

Icetype - within description, changed (1979-1991, 2008-2013) to (1979-1991, and
starting again in 2008).
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Aerial_Master_2012 2014 vO_11 VH

FLT221 E324, FLT225 E364, FLT240 E22, FLT246 E158, FLT262 E363, FLT270 E337, FLT202
E74, FLT2 E374, FLT13 E704, FLT245 E526 - SwimDir "."
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Aerial_Master_2012 2014 vO_10 VH
Edited by Amelia Brower

Edits to Aerial_Master_2012_2014 vO_10:

Made these changes:
X/Yofwhale -1, Lat/LongTemp changed to ArcLat/Long

to the following records:
ID9559 FLT207 E376
1D22474 FLT228 E503
1D26855 FLT234 E391
1D29513 FLT240 E31
1D29526 FLT240 E44
I1D46598 FLT266 E227
ID46750 FLT266 E527
ID47040 FLT267 E322
ID47611 FLT267 E114
ID47643 FLT267 E159
1D48090 FLT268 E332
I1D48672 FLT269 E382
1D48738 FLT269 E341
1D48783 FLT269 E423
1D49707 FLT270 E473
ID50704 FLT272 E486
ID50743 FLT272 E386
ID51568 FLT273 E450
ID57841 FLT11 E486
1D84150 FLT202 E294
ID85259 FLT204 E292
1D96952 FLT223 E338
1D99509 FLT227 E351
1D99585 FLT227 E353
1D108231 FLT240 E269
1D112621 FLT246 E260
1D113229 FLT246 E890
1D113712 FLT247 E131
ID114721 FLT247 E1130
1D118382 FLT252 E291
1D128526 FLT12 E1011
1D144407 FLT2 E197
ID151056 FLT10 E1020
1D151057 FLT10 E1021
ID155251 FLT15 E448
ID155515 FLT15 E1267
ID160736 FLT22 E227
1D161034 FLT22 EA475
ID161093 FLT22 E534
1D168257 FLT31 E592
ID171362 FLT233 E174
ID176326 FLT238 E1091
ID176507 FLT238 E1192
1D182199 FLT246 E276
1D185265 FLT251 E515
1D187081 FLT253 E768
ID187873 FLT254 E472
1D193546 FLT206 E462
1D201247 FLT217 E1022
1D201927 FLT218 E384
1D205510 FLT223 E159
1D205546 FLT223 E195
1D205794 FLT224 E122
1D209052 FLT228 E328
1D210828 FLT231 E415
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6/26/2015 Version History

gﬁ NMML Arctic Marine Mammal Research

NMML Arctic Marine Mammal Research > Shared Documents > BWASP Historical Data > Restricted >

Aerial_Master_2012_2014 > Version History

Versions saved for Aerial Master 2012 2014.accdb

All versions of this document are listed below with the new value of any changed properties.

Delete All Versions | Delete Minor Versions
No. 1  Modified

0.9 6/26/2015 3:01 PM

Modified By

Amelia Brower

0.8 6/2/2015 2:15 PM Amelia Brower

0.7 5/11/2015 4:09 PM Amelia Brower
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Size
84.5 MB

84.5 MB

84.5 MB

Comments

Edits to 2014:

ID 212294, FLT232 E1304 -
PhotoTaken=1

ID 188535, FLT255 E321 -
PhotoTaken=1

Edits:

2014, FLT 31:

E539, (ID 168204) - calfno
-1, Calf_on_circle -1, notes
"postscript: originally
thought to be mom/calf
due to lots body
contact/rolling; Craig
George determined they
were yearlings via photos.
Frame #0035 - 0060"
E609 (ID 168274) - calfno
-1, notes "postscript: Craig
George determined they
were yearlings via photos.
Frame #0061 - 0075"

Edits 4 of 4:

2014:

FLT238

E1328 - Final_group 750,
Low_estimate 750,
High_estimate 800,
Response yes, NoReacted
20, notes "marked on L
side, 3500, F72-84, CA;
rxn=flush; Final_group,
Low & High_estimate,
NoReacted determined via
post-flight photo
processing; likely spotted
seals, NMML pinniped
experts said spotted or
harbor seals, this is far
north of harbor seal range"

FLT241

E646 - notes "frames
0001-7, standing over
carcass E647".

E647 - notes "post script -
likely same carcass as seen
on 9/23, event 411;
F0001-0007; polar bear,
E647, standing over
carcass"

FLT243
E315 - Final_group 48,
Calfno 9

https://agora.afsc.noaa.gov/sites/nmmlarcticmarmam/_layouts/Versions.aspx?list={4D21643A-23B5-4B2F -BC22-CF C3BFF C8E15}&ID=8255&FileName=%2... 1/6
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Amelia Brower

Amelia Brower

84.5 MB

84.5 MB

FLT251

E507 - PhotoTaken 1.
E664 - notes "fr 28-29;
postscript: photos never
found", PhotoTaken 0.

FLT254
E635 - PhotoTaken 1.

FLT255
E321 - notes ".",
PhotoTaken 0.

FLT23

E166 - notes "3 adults 1
calf, 2 adults and calf
noticed on circle; J.Taylor
frames 1-12; postscript
open mouth in photos,
likely feeding"

E361 - notes "J.Taylor
frames 125-141; postscript
open mouth in photos, li

Edits 3 of 4:

2014:

FLT234

E109 - notes "bear was
running from carcass,
E104, when sighted,
slowed to a walk; carcass
looks to be half-buried."
E1034 - notes "fewer
animals (~20) seemed to
be at the surface by the
time we finished circling,
end frame 0123, Leah
Crowe; possible defecation
observed, fr106-8"

FLT 235

E149 - notes "sight cue
birds & dark spot, Frames
1-5, AW; brown bear E156
feeding on carcass"

E156 - Response yes,
NoReacted 1, notes
"rxn=look up; feeding on
carcass £149", PhotoTaken
1.

FLT238

E919 - Sightcue body.
E1281 - Final_group 697,
Low_estimate 697,
High_estimate 750,
NoReacted 150, notes
"rxn=flush; F48-63, CA;
Final_group, Low and
High_estimate, and
NoReacted determined via
post-flight photo
processing; likely spotted
seals, NMML pinniped
experts looked at photos
and said spotted seals or
harbor seals, but that this
is far north of harbor seal
range."

Edits 2 of 4:
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84.5 MB

2014:

FLT206

E547 - notes "sighted and
took photos of Norseman
11, fr 15-17"

E371 - notes "rxn=flush;
fr11-14; J.Gatzke"

E377 - notes ".",
PhotoTaken 0.

FLT210

E296 - notes "went back to
sighting after end of
transect line since circling
was not done initially;
wanted to confirm spp
and/or calves since so far
offshore; circling event not
recorded in database,
photos from circling,
J.Gatzke, fr2-12"

FLT 213

E613 - notes: "long trailing
slick; birds on it; photo
V.Beaver, fr1-10; post-
script: carcass resighted
on 6Aug2015, FLT219
E638"

FLT219

E638 - Species unid marine
mammal, notes: "in water
near beach. Fr19-24,
L.Barry; post-flight note:
resight of carcass on
26July2015, FLT213 E613"

FLT227

E397 - notes "frames 1-6;
E405 is a repeat of this
sighting and was a better
location, that location was
used for Level A"

E405 - Repeat yes, saved 1

FLT232

E1304 - notes "end frame
0120, Leah Crowe; photos
were grossly
underexposed, unusable",
PhotoTaken 0.

Edits 1 of 4:

2012-2014:

Skycon, removed trailing
space:

210996 211007 211018
211029211039 211050
211061 211072 211083
211103211114 211125
211132211143 211154
211165211175

Icepercent, removed
trailing space:

"3 ": 21588 28404 28407
54824 54827 60978 93740
93744 93749 93825

"4": 61188
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Amelia Brower

84.4 MB

"6 ": 54860

"7 " 9198 21435 51901
52538 52545 54830 54902
55182 55760 58831 58836
58841 58842 58843 58851
60224 60811 60813 63430
63505 63507 63509 63516
63522 63525 63595 63597
63599 63601 63681 63683
63686 64425 64426 65966
65971 66047 66048 93760
93777 93779

"8 ": 24645 61274 61275
61358 61361 61362 61365

2013:

FLT 32

E311 - end transect,
FitType 4, enttag 1

E315 - s on search, FltType
4

E322 - p on search, FltType
4

E325 - start trans, enttag

1

Appending 2014 data to
2012-2013 Master
database, Version History 3
of 3:

The way we got around
this was that I created a
blank database/table with
all the same table
structure (I copied the
Design view of the Output
table and pasted it into a
new table's Design view
and made sure TotalNo
was set to Long Integer
and saved it (as Output). I
saved the database as
Aerial_Master_2012_2014.
I ran append queries to
append the 2014 data and
the 2012-2013 master
data into the new
table/database. I also
copied the other tables
from the 2012-2013
Master database into the
new 2012-2014 Master
database and ran append
queries to append the
2014 FlightInfo and
Summarylnfo tables. For
the Summarylnfo to
append, I had to rename
the 2012-2013
Masterdatabase
Summarylnfo table field
headers to match 2014's.
I changed the following
headers with hyphens and
"&" to underscores:
Bowhead_Cow-calf_Pairs
Bowhead_Cow-
calf_Pairs_on_transect
Trans&CircMin
Trans&CircKilo

https://agora.afsc.noaa.gov/sites/nmmlarcticmarmam/_layouts/Versions.aspx?list={4D21643A-23B5-4B2F -BC22-CF C3BFF C8E15}&ID=8255&FileName=%2... 4/6
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Trans&ConMin
Trans&ConKilo

Appending 2014 data to
2012-2013 Master
database, Version History 2
of 3:

In 2014, when trying to
append 2014 to the 2012-
13 Master database, I got
this message: “Microsoft
Access set 1 field(s) to Null
due to a type conversion
failure..."

This was due to the walrus
TotalNo record of 35,000.
In the Output table of the
Master database, the
Design View > Field Size for
TotalNo is set to "Integer"
instead of "Long Integer".
Turns out the cutoff
between the two is
somewhere around
32,000, and since the
master database is set to
Integer, it couldn't handle
35,000, so changed it to
null during the appending.
So then, I tried to change
the Field Size for TotalNo in
the 2012-2013 Master
database to Long Integer,
but when trying to save it,
got this error message:
"Microsoft Access can't
change the data type.
There isn't enough disk
space or memory."

Appending 2014 data to
2012-2013 Master
database, Version History 1
of 3:

When attempting to open
the 2012-2013 Master
database, I received the
error message that the
library reference link to
OFFOWC.DLL v1.1. Thisis
related to the version of
Access being used and
happened because my
Office

has just been updated to
2013. My way of fixing this
was to click Ok through the
error messages when I
opened Access. Database
Tools > Visual Basic >
Tools > References >
unchecked the missing
library (MISSING: Microsoft
Office XP Web
Components); I didn't
check anything new
because there didn't seem
to be any updated Office or
Web Components.
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4/15/2014 Version History

iﬁ?ﬁ NMML Arctic Marine Mammal Research

NMML Arctic Marine Mammal Research > Shared Documents > BWASP Historical Data > Restricted >

Aerial_Master_2012_2013 > Version History

Versions saved for Aerial _Master 2012 2013.MDB

All versions of this document are listed below with the new value of any changed properties.

Delete All Versions | Delete Minor Versions

No. +  Modified Modified By

0.17 4/15/2014 3:06 PM Amelia Brower

0.16 3/17/2014 3:51 PM Amelia Brower

0.15 3/17/2014 12:56 PM Amelia Brower

0.14 3/17/2014 12:54 PM Amelia Brower
Page 30
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Size
56.8 MB

56.8 MB

56.8 MB

56.8 MB

Comments

ID406656 FLT244 E41 - bowhead
whale

Edits 2012:

ID361299 FLT20 E217 - Notes:
frame 1, PhotoTaken: 1.
ID321593 FLT232 E352 - Species:
walrus.

ID321700 FLT232 E558 -
PhotoTaken: 1.

Edits Part II/II:

1D413957 FLT251 E938,
1D413964 FLT251 E945,
ID413905 FLT251 E948,
1D413907 FLT251 E950,
1D413971 FLT251 E962,
ID413974 FLT251 E965 - Notes:
sea ice photos; PhotoTaken: 1.
ID413961 FLT251 E942 - Notes:
sea ice photos, frames 4-12;
PhotoTaken: 1.

1D435257 FLT29 E37 - Notes:
frames 1-5; PhotoTaken: 1.
1D426241 FLT15 E466 - Notes:
frames 29-30; PhotoTaken: 1.
1D426873 FLT15 E1104 - Notes:
added frames 0005_V-0037_V.
1D426875 FLT15 E1106 - Notes:
added frames 0005_V-0037_V.
I1D416666 FLT1 E565 - Notes: sea
state photo, frame 10;
PhotoTaken: 1.

Edits Part I/II:

ID411960 FLT249 E56, ID412022
FLT249 E67 - Notes: sea ice
photos; PhotoTaken: 1.
1D412187 FLT249 E232 - Notes:
sea ice photos, frames 25-49;
PhotoTaken: 1.

1D415969 FLT254 E359 - Notes:
sea ice photos, frames 17-35;
PhotoTaken: 1.

ID416012 FLT254 E444 - Notes:
sea ice photos, frames 47-48;
PhotoTaken: 1.

ID415718 FLT254 E622 - Notes:
sea ice photos, frame 75;
PhotoTaken: 1.

1D416397 FLT254 E793 - Notes:
sea ice photos, frames 107-114;
PhotoTaken: 1.

ID381273 FLT203 E545 - Notes:
frames 24-28; PhotoTaken: 1.
ID381368 FLT203 E575 -
PhotoTaken: 0.

ID396518 FLT228 E162 -
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2/20/2014 1:43 PM

11/26/2013 9:31 AM

11/21/2013 1:04 PM

11/12/2013 12:08 PM

11/5/2013 8:33 AM

11/5/2013 8:31 AM

Version History

Amelia Brower

Amelia Brower

Amelia Brower

Amelia Brower

Amelia Brower

Amelia Brower
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56.6 MB

56.6 MB

56.6 MB

32.9 MB

32.9 MB

32.9 MB

PhotoTaken: 0.

ID 399257, Event 369, Flt_No
231 - chgd "S on transect" to "s
on transect".

ID 386162, Event 653, Flt_No
211 - added "white adult" to
notes.

1D423490; F11 E496 (2013):
chgd Aerial_Survey from null to
'NMML_Cmdr', Swimdir_True from
null to '-1', saved from'0'to '1',
and added ArclLat and ArcLong to
LatTemp, LongTemp.

Appended
ASAMM2013_resummarized
Output, FlightInfo, and
SummaryInfo tables to
Aerial_Master_2012 tables

ID366905/FLT29 E289 - chgd
FltType from 2' to '4".

CLC Edits Part II/II

N=70 chgd habitat "large, broken
floe (old ice)" to "Irg broken floes"
N=174 chgd habitat "med-Ig floes
(old & new ice)" to "med broken
floes"

N=173 chgd habitat "on ice (near
lead or on floe)" to "on ice"

N=1 chgd habitat "river mouth"
to "river delta"

chgd "Jess Crance" to "Jessica
Crance"(observer n=95;
datarecorder n=196; obsleft
n=418; obsright n=636)

chgd "Jess Thompson" to "Jessica
Thompson" (observer n=139;
obsleft n=489; obsright n=471)
N=33 chgd obsright "Vicky
Beaver" to "Vicki Beaver"
Inserted NoReacted and alt_gps
fields to Output table design.
Updated field definitions in
Output table design.

CLC Edits Part I/II

1D373425,F40,E613,Yr2012:
chgd entry "s on circling" to "s on
circling - transect"

N=1 chgd spp "coast guard
vessel" to "vessel coast guard"
N=134 chgd spp "commercial
vessel" to "vessel commercial’
N=3 chgd spp "icebreaker" to
"vessel icebreaker"

N=1 chgd spp "lg. rec. vessel" to
"vessel Ig. rec.”

N=2 chgd spp "research vessel"
to "vessel research"

N=1 chgd spp "seismic vessel" to
"vessel seismic"

N=7 chgd spp "sm. rec. vessel"
to "vessel sm. rec."

N=9 chgd spp "small craft" to
"vessel small craft"
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8/6/2013 3:06 PM

3/13/2013 3:51 PM

1/31/2013 2:28 PM

1/9/2013 9:31 AM

1/8/2013 9:20 AM

1/7/2013 4:46 PM

1/7/2013 3:15 PM

Version History

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman
Page 32

32 MB

32 MB

31.9MB

32 MB

31.7 MB

31.7 MB

31.7 MB

Output:

ID355321;355381 - del trailing
space in skycon
1D332243;333679;335828 - del
trailing space in behavior

Changed Entry field design to
allow 50 characters.

Updated Entry & Flttype fields to
distinguish between transect
circling (n=1058) and search
circling (n=82).

Revisions were made by MHay on
5/8/2013.

lut_Flttype:
Changed code 5 to "circling -
transect" and added code 6.

1D328475/F243/E566/yr 2012 -
chgd notes from "lunge feeding"
to "adult lunge feeding"

Updated the Block field with the
following convention:

1. Only sightings have blocks
numbers; other records are
NULL.

2. To determine block
assignments, actual positions
were used when available,
otherwise plane positions were
used (LatTemp/LongTemp).

3. Sightings have blocks 1-22, if
in bounds.

4. Sightings have block 0, if out
of bounds.

5. Block boundary precision was
to three decimal places where
applicable (e.g., 71.333, 71.167,
etc.).

Inserted "PrimObs" column in
Output table.

Populated "PrimObs" column using
info from DataRecorder,
ObsLeft/Right/Fourth, Pilot, &
Co_Pilot fields. (n=3274 where
Observer=0bsLeft/Right;
n=79,794 where
Observer<>0bsLeft/Right;
n=83,068 total)

Added data definitions to Output
table design.

ID337505-337512/F258/E239-
246, year 2012: added comment
to notes regarding erroneous low
altitudes

ID355569/F14/E143, year 2012:
chgd behavior from "swim" to
"feed" based on info from daily
report

ID355857/F14/E358, year 2012:
chgd behavior from "rest" to "mill"
based on info from daily report

Extracted all 2012 data from
"Aerial_Master.mdb" and

34
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Page 33

imported into new database
"Aerial_Master_2012.mdb".
Aerial_Master.mdb file size had
become too large for SharePoint
server; renamed file as

"Aerial_Master_1979_2011.mdb".

New database
"Aerial_Master_2012.mdb" was
created.

2012 edit notes from
Aerial_Master Version History:
Output: ID341766/F265/E652 -
chgd enttag to 5

SummaryInfo: Subtracted refuel
time fromtotal and deadhead
minutes for 2012 F265.

Output=83,068 (2012)
FlightInfo/SummaryInfo=132
(2012)

4/4



4/15/2014 Version History

iﬁ?ﬁ NMML Arctic Marine Mammal Research

NMML Arctic Marine Mammal Research > Shared Documents > BWASP Historical Data > Restricted >

Aerial_Master_2012_2013 > Version History

Versions saved for Aerial _Master 2012 2013.MDB

All versions of this document are listed below with the new value of any changed properties.

Delete All Versions | Delete Minor Versions

No. +  Modified Modified By

0.17 4/15/2014 3:06 PM Amelia Brower

0.16 3/17/2014 3:51 PM Amelia Brower

0.15 3/17/2014 12:56 PM Amelia Brower

0.14 3/17/2014 12:54 PM Amelia Brower
Page 34
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Size
56.8 MB

56.8 MB

56.8 MB

56.8 MB

Comments

ID406656 FLT244 E41 - bowhead
whale

Edits 2012:

ID361299 FLT20 E217 - Notes:
frame 1, PhotoTaken: 1.
ID321593 FLT232 E352 - Species:
walrus.

ID321700 FLT232 E558 -
PhotoTaken: 1.

Edits Part II/II:

1D413957 FLT251 E938,
1D413964 FLT251 E945,
ID413905 FLT251 E948,
1D413907 FLT251 E950,
1D413971 FLT251 E962,
ID413974 FLT251 E965 - Notes:
sea ice photos; PhotoTaken: 1.
ID413961 FLT251 E942 - Notes:
sea ice photos, frames 4-12;
PhotoTaken: 1.

1D435257 FLT29 E37 - Notes:
frames 1-5; PhotoTaken: 1.
1D426241 FLT15 E466 - Notes:
frames 29-30; PhotoTaken: 1.
1D426873 FLT15 E1104 - Notes:
added frames 0005_V-0037_V.
1D426875 FLT15 E1106 - Notes:
added frames 0005_V-0037_V.
I1D416666 FLT1 E565 - Notes: sea
state photo, frame 10;
PhotoTaken: 1.

Edits Part I/II:

ID411960 FLT249 E56, ID412022
FLT249 E67 - Notes: sea ice
photos; PhotoTaken: 1.
1D412187 FLT249 E232 - Notes:
sea ice photos, frames 25-49;
PhotoTaken: 1.

1D415969 FLT254 E359 - Notes:
sea ice photos, frames 17-35;
PhotoTaken: 1.

ID416012 FLT254 E444 - Notes:
sea ice photos, frames 47-48;
PhotoTaken: 1.

ID415718 FLT254 E622 - Notes:
sea ice photos, frame 75;
PhotoTaken: 1.

1D416397 FLT254 E793 - Notes:
sea ice photos, frames 107-114;
PhotoTaken: 1.

ID381273 FLT203 E545 - Notes:
frames 24-28; PhotoTaken: 1.
ID381368 FLT203 E575 -
PhotoTaken: 0.

ID396518 FLT228 E162 -

174
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2/20/2014 1:43 PM
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Version History
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Amelia Brower
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56.6 MB

56.6 MB

56.6 MB

32.9 MB

32.9 MB

32.9 MB

PhotoTaken: 0.

ID 399257, Event 369, Flt_No
231 - chgd "S on transect" to "s
on transect".

ID 386162, Event 653, Flt_No
211 - added "white adult" to
notes.

1D423490; F11 E496 (2013):
chgd Aerial_Survey from null to
'NMML_Cmdr', Swimdir_True from
null to '-1', saved from'0'to '1',
and added ArclLat and ArcLong to
LatTemp, LongTemp.

Appended
ASAMM2013_resummarized
Output, FlightInfo, and
SummaryInfo tables to
Aerial_Master_2012 tables

ID366905/FLT29 E289 - chgd
FltType from 2' to '4".

CLC Edits Part II/II

N=70 chgd habitat "large, broken
floe (old ice)" to "Irg broken floes"
N=174 chgd habitat "med-Ig floes
(old & new ice)" to "med broken
floes"

N=173 chgd habitat "on ice (near
lead or on floe)" to "on ice"

N=1 chgd habitat "river mouth"
to "river delta"

chgd "Jess Crance" to "Jessica
Crance"(observer n=95;
datarecorder n=196; obsleft
n=418; obsright n=636)

chgd "Jess Thompson" to "Jessica
Thompson" (observer n=139;
obsleft n=489; obsright n=471)
N=33 chgd obsright "Vicky
Beaver" to "Vicki Beaver"
Inserted NoReacted and alt_gps
fields to Output table design.
Updated field definitions in
Output table design.

CLC Edits Part I/II

1D373425,F40,E613,Yr2012:
chgd entry "s on circling" to "s on
circling - transect"

N=1 chgd spp "coast guard
vessel" to "vessel coast guard"
N=134 chgd spp "commercial
vessel" to "vessel commercial’
N=3 chgd spp "icebreaker" to
"vessel icebreaker"

N=1 chgd spp "lg. rec. vessel" to
"vessel Ig. rec.”

N=2 chgd spp "research vessel"
to "vessel research"

N=1 chgd spp "seismic vessel" to
"vessel seismic"

N=7 chgd spp "sm. rec. vessel"
to "vessel sm. rec."

N=9 chgd spp "small craft" to
"vessel small craft"
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Version History

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman

Cynthia Christman
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32 MB

32 MB

31.9MB

32 MB

31.7 MB

31.7 MB

31.7 MB

Output:

ID355321;355381 - del trailing
space in skycon
1D332243;333679;335828 - del
trailing space in behavior

Changed Entry field design to
allow 50 characters.

Updated Entry & Flttype fields to
distinguish between transect
circling (n=1058) and search
circling (n=82).

Revisions were made by MHay on
5/8/2013.

lut_Flttype:
Changed code 5 to "circling -
transect" and added code 6.

1D328475/F243/E566/yr 2012 -
chgd notes from "lunge feeding"
to "adult lunge feeding"

Updated the Block field with the
following convention:

1. Only sightings have blocks
numbers; other records are
NULL.

2. To determine block
assignments, actual positions
were used when available,
otherwise plane positions were
used (LatTemp/LongTemp).

3. Sightings have blocks 1-22, if
in bounds.

4. Sightings have block 0, if out
of bounds.

5. Block boundary precision was
to three decimal places where
applicable (e.g., 71.333, 71.167,
etc.).

Inserted "PrimObs" column in
Output table.

Populated "PrimObs" column using
info from DataRecorder,
ObsLeft/Right/Fourth, Pilot, &
Co_Pilot fields. (n=3274 where
Observer=0bsLeft/Right;
n=79,794 where
Observer<>0bsLeft/Right;
n=83,068 total)

Added data definitions to Output
table design.

ID337505-337512/F258/E239-
246, year 2012: added comment
to notes regarding erroneous low
altitudes

ID355569/F14/E143, year 2012:
chgd behavior from "swim" to
"feed" based on info from daily
report

ID355857/F14/E358, year 2012:
chgd behavior from "rest" to "mill"
based on info from daily report

Extracted all 2012 data from
"Aerial_Master.mdb" and

34



4/15/2014

https.//agora.afsc.noaa.gov/sites/nnmiarcticnmarmany_layouts/Versions.aspx?list={4D 21643A-23B5-4B2F-BC22-CFC3BFFC8E 15} &ID=5240&FileName=%2Fsi...

Version History

Page 37

imported into new database
"Aerial_Master_2012.mdb".
Aerial_Master.mdb file size had
become too large for SharePoint
server; renamed file as

"Aerial_Master_1979_2011.mdb".

New database
"Aerial_Master_2012.mdb" was
created.

2012 edit notes from
Aerial_Master Version History:
Output: ID341766/F265/E652 -
chgd enttag to 5

SummaryInfo: Subtracted refuel
time fromtotal and deadhead
minutes for 2012 F265.

Output=83,068 (2012)
FlightInfo/SummaryInfo=132
(2012)
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